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1 Text conventions 

Menu items, file names, etc. are indicated in texts as follows: 

 Menu items, key combinations, dialogs, file names, entries, etc. are displayed in bold. 

 User-defined entries are shown in <bold and in angle brackets>. 

 Single-line example texts (e.g., a long directory path that covers several lines) are separated 
by  at the end of the line. 

 File extracts are shown in this font format: 

This paragraph contains a file extract. 
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2 General 

This manual provides an overview of PPM and, using examples, introduces you to basic 
functionalities. 

The quick start guide to process analysis is intended for PPM users being process owners or 
business analysts. 

Role definition 

As a process owner, you can  

 call predefined queries. 

 interpret the results in Performance Dashboards, Management views and reports. 

As a business analyst, you can 

 create basic analyses by using measures, dimensions, filters, and various views. 

 perform cause analyses for your processes and organizations. 

Tipp 

More information on PPM is available in the PPM user interface under PPM > Documentation. 



Process Analysis Quick Start Guide  
 

 

3 
 

3 PPM demo database 

PPM includes a demo database that you can use to familiarize yourself with the program. 

If you want to work with an example we recommend that you use the umg_en demo database. 
The demo database contains all measures and dimensions that you need for the examples. It is 
possible that the measures and dimensions in the use cases are not available due to the 
configuration of your company-specific PPM database. Of course, you can use any other process 
types, measures, and dimensions to work with the example. 

You can use PPM Customizing Toolkit to install the demo database. If you want to use the demo 
database, please contact your system administrator. 
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4 Introduction to Process Performance Manager 

Process Performance Manager (PPM) provides comprehensive analysis functions (Slice & Dice, 
ad-hoc analyses, reporting, etc.) to monitor and evaluate the performance of business units and 
business processes from various perspectives (e.g., results view vs. view of processes leading to 
results). By combining business process data, social interaction patterns, and result data users 
can create integrated analyses for measure evaluation. These analyses allow comprehensive 
insight into daily routines and results of a company and thus represent the basis for 
benchmarking and weak point analyses - e.g., early identification and resolving of bottlenecks or 
problematic interaction patterns. 

Process performance management 

Business processes are operational business activities. Effective company management 
therefore requires active business process controlling (Business Process Intelligence). 
Process performance management continuously monitors planned goals and warns in time if 
deviations from the plan occur so that suitable countermeasures can be initiated. This is how 
companies achieve improved process quality, which directly impacts business performance. The 
continuous monitoring of actual business processes therefore closes the gap between corporate 
strategy and its operational implementation.  

Process Performance Manager 

PPM supports you in analyzing your processes by providing comprehensive online analysis 
options based on measures and by representing your actual, measured processes. For an efficient 
process analysis, PPM gathers the necessary data from your operational systems, automatically 
reconstructs the processes across the whole system, and calculates the measures required for 
these processes. The individual process instances (Page 8), i.e., actual processes or 
transactions (e.g., an order #4711 received by FAX on 17-Sep-2005) are imported from a freely 
definable source system (such as SAP MM) and represented in an EPC (event-driven process 
chain). For data extraction from your source systems, PPM provides all required interfaces and 
extractors. 

Process analysis 

Process analysis mainly involves specifying process and function measures (cycle times, 
frequencies, costs, adherence to deadlines and quality guidelines), as well as representing the 
actual process in an EPC view. The visualization functions have been developed in such a way as 
to make a process view more informative and easy to read. PPM provides a wide selection of chart 
types and tables for you to display the results of your analyses clearly and in detail.  

Example 

The following illustrations show examples of a process analysis of the cross series processes of 
the Order processing. 
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The first example shows a trend chart with the process cycle time for the year 2008. It illustrates 
the development of the process cycle time in the course of the year and how the actual measure 
behaves in relation to the planned values. 

 

Example: Trend chart of process cycle time 

 

 

The following example shows a process instance in the form of an EPC, which PPM automatically 
generated based on the measured processes. It illustrates the actual flow of an individual process 
of the cross series process type (Page 9) in the Order processing process type group. 
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Example: Display process instance as EPC 

 
 

The following example illustrates the data measured by PPM for the selected process instance. 
The data of the process instance or the individual process elements, such as functions or events 
are displayed as attributes. 
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Example: Process instance attributes 

 

 

Tip 

The PPM user interface provides you with all of the functions required to set your analyses and 
display the results. 
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5 Key terms 

Process intelligence 
Process intelligence (Business Process Intelligence) describes a method for systematic 
analysis (collection, evaluation, representation) of business processes and company data 
(process data) in electronic form. The objective is to obtain conclusions that enable improved 
operative or strategic decision-making in terms of corporate goals. Process intelligence provides 
an objective basis for decisions pertaining to displaying and implementing improvement potential 
in real time. Automated analyses identify factors that affect process performance. 

Business process  
A business process is a sequence of activities aiming to achieve business results. A business 
process is usually run through multiple times, can be part of another business process or contain 
or trigger other business processes. Business processes often apply across departments and 
divisions and are therefore part of the company organization structure. 

Event-driven process chain (EPC) 
An event-driven process chain is a model type used to graphically describe the chronological 
sequence of a performance delivery process. The event-driven process chain is based on the 
following assumptions: 

 Each activity within a process is triggered by a commercially relevant change of state of an 
information object. 

 Each activity can result in a commercially relevant change of state of an information object. 

The status of a commercially relevant information object is graphically described by means of an 
event. Functions are used for the graphic representation of activities. 

Linking events and functions in series and connecting these objects with directed connections 
graphically represents the control flow of the process. Since an event can trigger several 
functions and since a function can have several events, the process path can branch. AND, OR, or 
EXCLUSIVE OR rules are inserted at branches of the process path. They illustrate the logical 
relationship that exists between the sequenced objects. 

Organizational units can be assigned to a function. An organizational unit describes the group of 
processors in the company which executes the function in question. Organizational units are 
linked to the relevant function using connections. 

EPCs are used in PPM to represent processes actually executed in the past (so-called process 
instances). 

Process instance 
Concrete occurrence of a process, e.g., processing of standard order 4711. A process instance 
describes the sequence of activities performed in the company to deliver a required product or 
service. 
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Process instances provide the data base for calculation of the measures in PPM. They are provided 
by a data import from a source system. 

In PPM, the EPC (Page 8) model type is used for the graphic representation of process instances. 

5.1 Process type 

All process instances are classified when you import data into PPM. They are therefore assigned 
to process types. This assignment ensures that order processing transactions are not compared 
against return transactions, for example. 

5.2 Measure 

In business, measures represent aggregated information on quantifiable operating facts. They 
are intended to enable easy control of processes and results. 

Example 

An example of a measure is the process duration (or process cycle time). It is calculated based on 
two process instance measurement points, Start time and End time. The 
calculation/measurement is performed for each process instance. When analyzing multiple 
process instances, the measurement values of the individual instances are aggregated (e.g., by 
averaging) and the aggregated values are then displayed in PPM. Measures are sometimes 
referred to as metrics, as well. 

Measure evaluation 

The rating of a measure indicates the effects of an increasing measure value on the achievement 
of your process goals.  

 Positive means that rising values have a positive effect on goal accomplishment (e.g., 
number of orders). 

 Negative means that rising values have a negative effect on goal accomplishment (e.g., 
process cycle time). 

 

5.3 Dimension 

Dimensions are criteria according to which the measures analyzed can be differentiated (for 
example, sales organization or order volume).  

Dimensions can be configured in terms of step width and value range. For example, the Time 
dimension can be displayed with the step widths Year, Quarter, Month, Week, Day, or Hour. 
The incremental calculation or analysis of a measure via a dimension is also called iteration. You 
can restrict the value range using filters. For the Time dimension, the value range can be 
defined as a period (e.g., time from 07/01/01 to 07/01/02). 



Process Analysis Quick Start Guide  
 

 

10 
 

5.4 Filter 

Filters limit the number of process instances to be included in the aggregation of a measure 
during analysis. You can define filters for measures and dimensions. Each filter describes a 
specific value range for a measure or dimension, and process instances falling within this range 
will be included in the analysis. 

5.5 Planned value 

A planned value describes the objective for individual process measures that you can specify in a 
planned value definition. A planned value definition consists of two numerical values. 

Planned value 1 is the value above or below which the measure moves into a critical range. As 
soon as the measure infringes this planned value (green-yellow limit), accomplishment of the 
process goal is jeopardized and you should initiate improvement measures immediately. 
Planned value 2 (yellow-red limit) corresponds to the planned measure value. As soon as the 
measure infringes this planned value, the goal has not been accomplished. 

5.6 Query 

Queries summarize the configuration of analyses, e.g., filters, dimensions, measures and view 
type. 

You can use the PPM user interface to interactively set up and run a query and display the analysis 
results. 

Favorite 
A favorite is a shortcut to quickly access a query that already exists. Using favorites, you can, for 
example, create frequently used queries and reuse them. 

A favorite does not store the actual values of a query, but the following criteria: 

 Process types or functions 

 Measures 

 Dimensions 

 Filter 

 View 

 Formatting of the individual views 
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6 Start the PPM user interface 

This chapter describes how to start the PPM user interface. 

To use PPM, you must log in as a user to an available PPM client. Depending on how PPM was 
installed, you call up the user interface via a Web browser or start it as a local installation. 

Before you can start the user interface you need to start the required infrastructure components 
and PPM components. 

In PPM, the system user is created with the password manager by default. You log in with this 
user/password combination if the password has not been changed and if you have not been 
configured as a PPM user. 

Tip 

For further information on PPM installation, please refer to the document PPM Installation or 
contact your system administrator. 

Procedure 

1. Open the Windows Start menu and click Start PPM Core <version> in the  Software AG 
> Start Servers program group. 

The infrastructure components and PPM components start. As soon as the start process is 
completed, you can start the PPM user interface. 

2. Open the Windows Start menu and click PPM GUI <version> in the Software AG > Tools  
program group. 

The login dialog is displayed. 

 

3. Enter system in the User box. 

4. In the Password box, enter the password manager. 
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5. In the Client box, enter the client name umg_en. 

6. Click Next. 

7. In the Language box, select the language that PPM is to be displayed in. 

 

8. Enable the option Save login data if you want to save the login data entered for the next 
login. The password will not be saved. 

9. Click Log in. 

The PPM user interface is started and the start page is displayed. 
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Example: PPM start page 

 

 

The PPM start page provides quick and easy access to your analyses. (Page 33) 
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7 Analyze processes 

This chapter uses a complete use case example to describe basic PPM functionalities. 

For your process analysis, the following questions must be considered. 

 What is the goal of your analysis (for example, do you want to find out about the causes of a 
planned value deviation or conduct a performance analysis of particular processes)? 

 Which processes in your company do you want to analyze, e.g., sales or order processing? 

 Which measures (e.g., sales or process cycle time) do you want to view for which 
dimensions (e.g., sales or sales organization)? 

 What is the best view type (e.g., chart or table) for the results of your analyses? 

Example 

Situation 

Several customers complained about very long processing times of their orders and that 
deadlines were not met. You should therefore find possible weak spots in your company 
processes. 

Procedure 

You want to examine the Order processing processes, in particular the cross series processes 
with a view to planned value deviations and suspected deviations pertaining to Process cycle 
time. 

First, you query the process performance of the cross series in order processing. Then you 
perform your analysis in detail for your company's Dealers for the year 2009. In addition, you 
evaluate the analysis results by quarter. Using the process instance analysis, you examine the 
suspected deviations in your processes. You display your analyses in various views in structured 
charts and tables and make them available as a PDF document. 

Your procedure consists of the following steps: 

 Display a predefined query 

 Create a 2D and 3D column chart 

 Create list table 

 Determine process instance distribution 

 Display anomalous process instances as an EPC 

 Perform EPC benchmark 

 Output analyses as a PDF document 
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7.1 Display favorites 

You want to display suspected deviations in the processes of the SUV series area. This is an 
analysis that you will frequently use to find out in time about possible anomalies in your 
processes. 

A predefined query (Page 10) is available as a favorite (Page 10) to do this. With this favorite, you 
can easily run frequently used queries (Queries bar). 

Procedure 

1. Select the Process analysis module. 

2. Click Private favorites in the Favorites bar. 

3. Double-click the 01 Process cycle time favorite. 

A speedometer chart displays the current average process cycle time relative to the defined 
planned values. With 83 days, the process cycle time is in the critical range and deviates from the 
defined planned value 2 (yellow/red limit). 
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Example: Process performance in the SUV series area  

 

7.2 Save analyses 

You want to save your current analysis results to be able to reuse them later. 

To do so, you can copy your analysis to the Clipboard panel. The Clipboard panel keeps your 
analysis for the duration of your current PPM session. 

Procedure 

1. Display the Clipboard tab bar. 

2. Click the Apply button. 

Your current analysis is saved in the Clipboard panel and displayed as a thumbnail. 

Tip 

If you want to reuse your analysis in a subsequent PPM session you can save it as a favorite. 

For detailed information on this topic, please refer to the PPM help topics. 
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7.3 Display analysis as a chart 

You want to analyze the process performance of the cross series processes in detail for the year 
2009, and you suspect weak spots at your dealers. Your analysis is to be displayed in a clear and 
easy-to-read chart. 

The analysis of only one measure (Page 9) (Process cycle time) and one dimension (Page 9) 
(Dealer) can easily be displayed in a 2D column chart. 

Use a wizard to create your analysis. 

In the wizard, set the following items for your analysis. 

 View type: 2D column chart 

 Processes: SUV series of Order processing 

 Measure: Process cycle time 

 Dimension: Dealer 

 Filter: 2009 

Procedure 

1. Display the Basis tab bar. 

2. Click  New. 

3. Click the Two-dimensional chart button. 

4. Click Run. 

5. Click the Column chart button. 

6. Click Next. 

7. Double-click the Order processing process type group in the process tree. 

8. Select the cross series process type. 

Only the process instances of this process type will be evaluated. 

9. Click Next. 

10. Select the Process cycle time measure. 

The process cycle times of the process instances you selected in the previous step are 
analyzed. 

11. Click Next. 

12. Select the Dealer dimension. 

The process cycle times of the standard orders are analyzed for the selected dealers. 

13. Click Next. 

14. Double-click the Time dimension. 

a. Enter 2009 on the Absolute tab. 
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b. Click OK. 

Only data for the year 2009 will be analyzed. 

15. Click Finish. 

Your process analysis is displayed as a 2D column chart. 

 

Example: Process cycle time/Dealer process analysis as a 2D column chart 

 

7.4 Display measure values and legend in the chart 

You want to display the measure values for each dealer in your chart and also want to show a 
legend. 

Procedure 

1. Display the Basis tab bar. 
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2. Click  Display options. 

3. Display the Chart settings page. 

4. Select the Absolute option in the Measure values group box. 

5. Display the Labels page. 

6. Enable the Display legend option. 

7. Display the Colors page. 

8. Enable the Highlight values option in the Display effects group box. 

Now the measure values and a legend are displayed in your chart. 

Tip 

You can move the displayed legend in the chart using the mouse. 

7.5 Display planned values 

You want to display planned values (Page 10) in your chart to see which of your dealers meet or 
deviate from the planned values. 

Additionally, you display the planned values and measure areas in your current analysis. 

Procedure 

1. Display the Query tab bar. 

2. Click the Show planned values ( ) button. 

The planned values and the corresponding measure areas are displayed in color in your chart. 

Planned value 1 indicates the borderline between the uncritical area (green) and the 
unfavorable area (yellow), while Planned value 2 demarcates the borderline to the critical area 
(red).   
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Example: Display planned values in process analysis 

 

7.6 Set filter 

You want to limit your process analysis to the two dealers with the longest process cycle time and 
compare them to the dealer with the shortest process cycle time. 

To do so, set a filter (Page 10) for your dealers that returns the dimension steps with the relevant 
measure values. The filter includes the dealers in Frankfurt and San Francisco, both of which are 
close to planned value 2, and Munich with the shortest process cycle time. 

Procedure 

1. Enable the Filters bar.  

2. Display the Filters tab bar. 

3. Click  Select criteria. 

4. Double-click Dealer in the Available dimensions/measures column. 

5. Click OK. 
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The filter criterion Dealer is added to the Filters bar. 

6. Click  Expand in front of the Germany and USA filter values under the filter criterion 
Dealer. 

The tree expands accordingly. 

7. Enable the filter values Frankfurt, Munich, and San Francisco. 

The column chart displays only the columns for Frankfurt, Munich, and San Francisco. 

8. Set the sort direction for the chart axis.  

a. In your chart, right-click the Dealer dimension. 

b. Select Sort axis values. 

c. Select Ascending as direction and Process cycle time as sort criterion. 

d. Click OK.  

The set filter is applied to your analysis and the dimension steps are displayed in your chart in line 
with their measure values in ascending order. 

 

Example: Process analysis with filter 
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7.7 Replace dimension 

Next, you want to analyze the process cycle times for the SUV series area for the year 2009. 

To do this, you can replace the Dealer dimension with the Time dimension directly in your chart. 

Replace dimension 

Procedure 

1. In your chart, right-click the Dealer dimension and select Replace dimension. 

2. Select the Time dimension. 

3. Click OK. 

The new Time dimension and the Process cycle time measure with the corresponding planned 
values are displayed in your chart. 

Tip 

Alternatively, you can replace a dimension by drag and drop. To do this, display the Dimensions 
bar and drag the relevant dimension with the mouse to the desired position in your chart. 

You can also replace measures in your analysis using the same procedure. 

7.8 Set step width 

You want to summarize the display of the set Time dimension in quarters instead of displaying it 
in months. 

To do so, set the step width of the Time dimension.  

Procedure 

Set step width 

1. Display the Settings bar. 

2. For the Time dimension, click the currently set step width. 

3. Enable the By quarter option. 

4. Click OK. 

The set step width is applied to your analysis and displayed as a single column in your chart. 
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Example: By quarter step width of the Time dimension 

 

7.9 Add dimension 

You want to display the two individually analyzed dimensions in one chart to determine possible 
interrelations. 

To do so, add the Dealer dimension of your current analysis to the Time dimension and hide the 
planned values from your chart for better reading. 

Procedure 

1. Display the Query tab bar. 

2. Click  Select dimensions. 

3. Double-click the Dealer dimension. 

4. Click OK. 
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5. Click  Hide planned values in the Query tab bar. 

The additional dimension is added to your analysis and displayed in your chart. The individual 
sales organizations are grouped for each quarter in line with the set step width. 

In the fourth quarter of 2009, the process cycle times of the three dealers are almost identical.  

 

Example: Process analysis with the Sales organization and Time dimensions 

 

7.10 Change analysis view 

To obtain a better overview, you want to display each dimension of your analysis on its own chart 
axis. Besides, you want to summarize your analysis in a table and display the planned values. 
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To do this, select the corresponding analysis view. To display the analysis of two dimensions and 
a measure, you can select a 3D column chart, for example. To display planned values in a table, 
a list table is recommended for an analysis view. 

Display 3D column chart 

Procedure 

1. Display the Visualization tab bar. 

2. Click  Select analysis view. 

3. Double-click the 3D column chart button. 

4. Set descending sort direction for the Dealer axis. 

(See chapter Set filter (Page 20)) 

5. To render the chart clearer, set the color of the columns for the dealer in Frankfurt. 

a. Right-click a column of the Frankfurt dealer. 

b. Click Edit color assignment in the pop-up menu. 

c. Select a color. 

d. Click OK. 

The changed settings are applied to your current analysis. 
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Example: Analysis of a measure and two dimensions in a 3D column chart 

 

 

Display list table 

Procedure 

1. Display the Visualization tab bar. 

2. Click  Display list table. 

3. Display the Query tab bar. 

4. Click  Show planned values. 

5. In the table, click the header of the column Process cycle time to sort the table in 
descending ( ) or ascending ( ) order. 

The changed settings are applied to your current analysis.  
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The list table is sorted by process cycle time including planned values 1 and 2. The measure 
values are colored in line with your goal accomplishment. 

 

Example: Analysis of a measure and two dimensions with planned values as a list table 

 

7.11 Display process instance distribution 

You want to know how process instances distribute to the various process cycle times or, in other 
words, you want to see with which process cycle times the most processes are executed in the 
SUV series area. 

To do so, create a distribution chart for your analysis. A distribution chart displays the number of 
process instances for a distributable measure. 

You can create a distribution chart either using a wizard or, if your current analysis already 

contains the relevant measure, using  Show distribution. 

Procedure 

1. Display the Query tab bar. 

2. Click  Show distribution. 

3. Display the Clipboard tab bar. 

4. Click the Apply button. 

A distribution chart is displayed for the set Process cycle time measure and your query is saved 
in the Clipboard panel. 

Most process instances are in the uncritical area (green), but are very close to the average value. 
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Example: Distribution chart of the Process cycle time measure 

 

7.12 Display process instances  

You want to view the process instances in the critical area in detail. The data range of interest 
comprises the process cycle times 81 to 180 days, which are above the defined planned value. 

Display a list of the critical process instances for the corresponding data range. 

Procedure 

1. Display the Visualization tab bar. 

2. Click  Select data range. 

3. With the mouse, drag a selection frame in the chart around the columns of the data range 
81.0-90.0 to 171.0-180.0 days. 

The area is now selected. 

4. In the selected area, click  Display menu. 
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5. Click Display process instance table in the pop-up menu. 

The process instance table with the critical process instances of the selected area is 
displayed. 

6. Click the header of the column Process cycle time to sort the table by process cycle time in 
descending order. 

7. From the list, select the process instance with the longest process cycle time. 

The EPC pertaining to the selected process instance is displayed. 

 

Example: Process instance and EPC with the longest process cycle time 
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7.13 Compare processes 

You want to compare process instances with long and short process cycle times to identify 
possible weak spots in the process. 

To do so, compare the two aggregated EPCs of the respective process instances. An aggregated 
process creates an aggregated process from multiple process instances and assigns a probability 
of execution to each path in the process. 

Use the Clipboard panel to compare two EPCs. 

Tip 

To improve the process display, you can hide organizational units and events in the displayed 
EPC. Only functions and start and end events of the EPC are displayed now. 

Aggregated EPC with long process cycle time 

Procedure 

1. Click in the process instance table and select all process instances by pressing Ctrl and A. 

All process instances in the table are selected and an aggregated EPC of all selected process 
instances is displayed. 

2. Display the Basis tab bar. 

3. Click  Display options. 

4. Display the EPC view settings page. 

5. Disable the Organizational units and Events options in the Display box. 

6. Click OK. 

Organizational units and events are no longer displayed. 

7. Display the Visualization tab bar. 

8. Click  Fit to window. 

The complete EPC is displayed in the window.  

9. Display the Clipboard tab bar. 

10. Click the Apply button. 

Your current query is saved in the Clipboard panel. 

Aggregated EPC with short process cycle time 

Procedure 

1. In the Clipboard panel, double-click the previously created distribution chart. 

The distribution chart is displayed. 

2. In the chart, right-click the bar with the shortest process cycle time. 

3. Select Display process instance table. 
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The table of process instances with the shortest process cycle time is displayed. 

4. Click in the table and select all process instances by pressing Ctrl and A. 

All process instances in the table are selected and an aggregated EPC of all selected process 
instances is displayed. 

5. Display the Basis tab bar. 

6. Click  Display options. 

7. Display the EPC view settings page. 

8. Disable the Organizational units and Events options in the Display box. 

9. Click OK. 

10. Organizational units and events are no longer displayed. 

11. Display the Visualization tab bar. 

12. Click  Fit to window. 

The complete EPC is displayed in the window. 

13. Display the Clipboard tab bar. 

14. Click the Apply button. 

Your current query is saved in the Clipboard panel. 

Compare processes 

Procedure 

1. Select both queries in the Clipboard panel. 

2. In the Clipboard tab bar, click the Benchmark button. 

Both processes are displayed in one window side by side in their EPC views. 

You can now compare both processes in detail and examine them for process weak spots. 
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Example: EPC benchmark on process cycle time 
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8 General handling 

This chapter contains information on the general handling and basic functions of PPM. 

Please select a subentry. 

 

8.1 Quick-start an analysis 

Use default queries to start a predefined analysis and customize it in line with your requirements. 

Each analysis realm provides you with a specific, predefined analysis if it was created during client 
customizing. When you open process analysis or a Data analytics analysis realm for the first time, 
the default query is displayed immediately. When you open it again, the analysis you last 
configured is displayed. 

Procedure 

1. Display the PPM start page. 

2. Open the relevant analysis realm. 

When you open the organizational analysis, click  Start. 

The default query with the predefined settings is displayed in the analysis realm. 

As in all other analyses, you can replace and set measures, dimensions, filters, etc., in the default 
query. 

You can display the predefined default query again any time. 

See also 
Use the PPM start page 

Set analysis content 

8.2 Adapt user interface 

PPM provides you with various options for adapting the user interface to meet your requirements. 

You can place individual bars and views at a particular position using drag and drop, combine 
multiple bars, show or hide bars and adjust their size. 

 Move views (Page 34) 

 Swap views (Page 34) 

 Adjust view size (Page 34) 

 Move bars (Page 35) 

 Combine bars (Page 35) 

 Show and hide bars (Page 35) 

 Adjust bar size (Page 36) 
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 Show and hide tab bars 

 Change tab order (Page 36) 

When you exit an analysis realm your bar position settings will be saved. 

You can restore the original bar positions (Page 36). 

8.2.1 Move views 

You can move individual views in a multi-panel analysis using drag and drop. 

Procedure 

1. Create a multi-panel analysis. 

2. Click in the header of a view. 

3. Hold down the mouse button and move the view to the relevant position using drag and drop. 

A frame with the label Insert view is displayed where the bar will be positioned. 

The view is moved to the selected position. 

See also 
Swap views (Page 34) 

8.2.2 Swap views 

You can swap the position of individual views in a multi-panel analysis using drag and drop. 

Procedure 

1. Create a multi-panel analysis. 

2. Click in the header of a view. 

3. Hold down the mouse button and use drag and drop to move the view to the center of a view 
whose position you want to swap. 

A frame with the label Swap view is displayed. 

The positions of the two views are swapped. 

See also 
Move views (Page 34) 

8.2.3 Adjust view size 

You can adjust the width and height of the individual views in a multi-panel analysis. 

Procedure 

1. Create a multi-panel analysis. 

2. Move the mouse pointer on the separating line of a view.  
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3. Move the separating line in the relevant direction while holding down the mouse button. 

The size of the view is automatically adjusted. 

8.2.4 Move bars 

You can move individual bars using drag and drop. 

Procedure 

1. Click in the header of a bar. 

2. Hold down the mouse button and move the bar to the desired position using drag and drop. 

A frame is displayed at the location in which the bar will be positioned. 

The bar is moved to the selected position. 

8.2.5 Combine bars 

You can combine multiple bars into one single bar. The bars are displayed as individual tabs in the 
new bar. 

Procedure 

1. Click in the header of a bar. 

2. Hold down the mouse button and use drag and drop to move the bar to the desired area or 
bar you want to combine it with. 

A frame is displayed around the selected bar. 

The two bars are displayed as individual tabs in the new bar. 

Click the title of a tab to display the bar. 

8.2.6 Show and hide bars 

You can hide bars that are not required for your current analysis and show them again later. Thus, 
you create more space for displaying the analysis area. 

Procedure 

Hide bars 

1. Display the View tab bar. 

2. Click the button with the name of the bar you want to hide, e.g., the Favorites ( ) bar. 

The selected bar is hidden.  

Alternatively, you can click  Close in a bar's title bar.  

Show bars 

1. Display the View tab bar. 
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2. Click the button with the name of the bar you want to show, e.g., the Favorites ( ) bar.  

The bar is displayed. 

Tip 

Use the bar at the right side of the work area to quickly show and hide bars. 

Click the corresponding button in the bar, e.g., Favorites ( ). 

Click  Hide bars to hide all bars that are currently displayed. 

8.2.7 Adjust bar size 

You can adjust the width and height of the bars. 

Procedure 

1. Move the mouse pointer on the separating line of the bars.  

2. Move the separating line in the relevant direction while holding down the mouse button. 

The size of the bar is adjusted. 

8.2.8 Change tab order 

You can change the order of the tabs displayed in a bar. 

Procedure 

1. Click the tab header. 

2. Use drag and drop to move the tab to the position in which you want to place it. 

The tab is moved to the selected position. 

8.2.9 Restore bar positions 

You can restore the original positions of the various bars. 

Procedure 

1. Display the View tab bar. 

2. Click the Reset bar positions button. 

3. Click Reset. 

PPM closes automatically. 

4. Restart PPM to restore the original bar positions. 

After restarting PPM, the bars will be displayed at their original positions. 
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8.3 Quickly find entries in lists and tree structures 

You can use the keyboard to quickly find entries in various bars, certain dialog boxes, and tables. 

1. Click the first entry in the interface element that you want to search, e.g., the first row in a 
table. 

2. Then enter the first few letters of the word you want to find. 

The selection will jump to the first position that begins with the letter combination you entered. 

Tip 

In some interface elements, such as the Dimensions and Measures bars, you can use custom 
search boxes to browse the list displayed. 
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